Printin

The following guidelines are intended to assist you through the process of creating
a print-ready publication that will meet industry standards for Web Offset printing.
Our goal is to provide you with the resources you need to insure that the print files
you submit will result in the best reproduction at press without delays or added cost
being incurred.

If you have any questions, feel free to contact one of our sales or customer
service representatives at 866.262.4449.
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Glossary of Print Terms

Bleed - A bleed is any image or graphic component that extends beyond the page edge.
Bleeds can be used only on publications that trim. Any item that is to bleed must be extended
1/4”" beyond the trim edge of the document. Be sure your pdf settings are set correctly to
capture the bleed.

CMYK - Cyan, Magenta, Yellow and Key (Black) are the colors used in 4 color process
printing. The CMYK color model (process color, four color) is a subtractive color model
and is also used to describe the printing process itself. Though it varies by print house,
press operator, press manufacturer and press run, ink is typically applied in the order of the
abbreviation.

Color Densitometer - A piece of equipment used by press personnel to determine the
density of the ink color being laid down on the printed sheet. Color Density - The amount
of ink printed on the sheet.

CTP - Computer to Plate. A technology that allows the imaging of metal or polyester
plates without the use of film. Eliminating the stripping, compositing, and traditional plate
making processes, CTP revolutionized the printing industry and led to reduced prepress
times, lower costs of labor, and improved print quality. Recently Stafford began using a plate
that requires no chemistry to process. It goes directly from imagesetter to press.

Halftone - The screening of a continuous tone image, converting the image into different
sized, yet, equally spaced dots - or in stochastic printing, which Stafford uses,a random dot
pattern that more closely resembles a continuous tone, providing clearer, sharper images.

Offset - The printing process that uses a blanket to receive the ink from the plate and
then impresses it onto the paper as the paper passes between the blanket and a hard steel
cylinder called an Impression Cylinder.

Registration - The alignment of the four process colors in relation to each other. When
the cyan, magenta, yellow and black plates are aligned and brought into focus, the printed
piece is considered to be in register.

RGB - The RGB color model refers to red, green, and blue, which as light is added togeth-
er in various ways to reproduce a broad array of colors.The RGB color model is for the
sensing, representation, and display of images in electronic systems, such as televisions and
computers, and digital photography. In offset printing, RGB images imported for your digital
camera must be converted to the CMYK color mode in a program such as Photoshop prior
to printing to achieve accurate color reproduction. Leaving images in RGB mode will result
in a much darker, muddy image in print.

RIP - Raster Image Processing, a computer language that arranges the dots, solids, lines and
type in a particular pattern concerning densities and angles. The function of the RIP is to
send instructions to the plate or proofing imagesetter.

Saddle Stitch - The binding of a book using wire staples on the binding edge to hold the
book together.

Separations - In the printing process four different colored inks are used - cyan, ma-
genta, yellow and key (black), - together abbreviated as CMYK. These inks are semi-trans-
parent or translucent. When two or more inks overlap on the paper due to sequential
printing impressions, a primary color is perceived. In the “pre-press” stage, original images
are translated into the four color plates that can be used on a printing press, through “color
separation,” and “halftoning”’ These steps make possible the creation of printing plates that
can transfer color impressions to paper on the printing press.

Signature - A parent sheet that consists of 4, 8 or 16 pages depending on the size of the
publication and the press that it is to run on.The signature is then folded, collated (depend-
ing on how many pages are needed to complete the project), stitched and (sometimes)
trimmed.

Spot Color-PMS-Pantone - Colors that are mixed in batches and are identified by a
number. The number can be followed by a C (Coated) or U ( Uncoated). The formula is de-
signed for the type of substrate it is to be printed on taking into consideration the porosity
of the paper. For cold-web offset printing, Uncoated PMS colors are used.

Stochastic screening - or FM screening is a halftone process based on pseudo-random
distribution of halftone dots, using frequency modulation (FM) to change the density of dots
according to the tone level desired. Traditional (AM) halftone screening is based on a fixed
spacing of dots, which vary in size depending on the tone represented. Stochastic screen-
ing, which is used by Stafford, employs a fixed dot size with a distribution density that varies
depending on the color's tone. The result is an image that exhibits a greater color gamut
than conventional (AM) halftone screening, is clearer, and more closely resembles a continu-
ous tone image.

Trapping - The overlay or over printing of ink in relation to each other to compensate
for miss-registration on the printing press creating an illusion of tight register.

Web Press - A high speed printing press that uses rolls of paper rather than individual
sheets. Web Offset Presses are beneficial in long run printing jobs. Speed is a huge factor
when considering turn around time for press production; some web presses print at speeds
of 3,000 feet per minute or faster. Stafford’s web press can average 20,000 impressions an
hour. In addition to the benefits of speed and faster turn around times, some web presses
have the inline ability to cut, perforate, and fold.
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LAYOUT FORMATS

\
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The most common web press layout formats are Broadsheet, the largest page size;Tabloid, half
the page size of a broadsheet; and Mini-Tab, which has a page size that is half that of a tabloid page.
Within each format, sizes can vary either in width, height or both. Each are achieved on the same press
by how the folds are made in the web.

BROADSHEET

¢ Traditional newspaper format

¢ Sized from 11.5 to 17” wide by 23” tall

* Page counts are factored in two page increments

* Can fold to either display half of the front page, or quarter of front page

TABLOID

* A tabloid can be ready straight off the press untrimmed, or sent to post
press to be stitched and trimmed

¢ Untrimmed tabloids have a width of 11.375” wide but can vary in height
from 12 to 17” tall

* Can be left as a flat fold, to display the full front page, or folded in half
(quarter folded) with the fold across the middile of the front page (often
done for mailing purposes)

* Trimmed tabloids range from 9.5 to 10.5” wide by 12 to 16” tall.
Stitching and trimming is done post-press

* Page counts are factored in increments of four

MINITAB

e A mini-tab is a stitched and trimmed product that can be produced in a
variety of sizes, usually from 6 to 8” wide by 10 to 10.5” tall
* Page counts are factored in increments of 8.




USING DESIGN AND LAYOUT APPLICATIONS

Adobe InDesign and QuarkXpress are the two industry standard layout applications that are
used to create professional print-ready pdf files to submit for printing your publication. Of the
two,

InDesign has become the application used most often by graphic designers.

When setting up your publication, the document size you create must be the same as your
intended actual page size. For example, if you are creating a mini-tab that will be a finished
(trimmed) size of 8 x 10.5” be sure to set your document template to this size. At this size
we recommend a 3/8” inside margin to give you a live working area of 7.25” x 9.75”. The live
area defines the limit for all printable text.

MNew Document

Document Preset: ' [Custom]

Intent: | Print { |
T T

( Cancel

Number of P : 16 Facing P mTEETTET—
Sibabudi “ kel i [ Save Preset... |

H
[ Fewer Options |

Start Page #: 1 "1 Master Text Frame

£y

— Page Size: | [Custom)] 4

S % : N .. Page size should be
MRS 18 in Orientation: set to actual finished

Height: < 10” page / publication
51Ze.

— Columns

Number: = 1 Gutter: = 0.1667 in

[1Meraing | By clicking tolockthe
Top: < 0.375 in Inside: <+ 0.375 in fink icon, the margin
—— —— || settings vdl he
Bottom: < 0.375 in Outside: —0.375 in applied evenly to all

four sides.

— Bleed and Slug

Top Bottom Inside Outside k& Unlock the link icon

. : : 5 . : to apply bleed to
Bleed: 0.25in |0.25in | Qin 0.25in | & Top, Bottom, Oltside

Slug: 0 in 0in 0in 0in i leaving Inside at 0.

SETTING UP BLEEDS
A bleed is any image or design element that extends off of the printed piece. Bleeds can be
used only when the printed piece is going to be trimmed.Your bleed elements must be extended 1/4”
beyond the trim edge of the document.

When creating a pdf of your final layout document, it’s very important to allow for the extra
1/4” of bleed by checking the appropriate box in the pdf settings.




COLOR SETUP

There are two different types of color inks that are used in web offset printing:
Process Color and Spot color:

PROCESS COLOR (4 COLOR) This is the process used most often, required when running color
photos or artwork. In your design application, all colors created must be set up with the Color Type set

to Process and the Color Mode set to CMYK. Colors in InDesign are setup using “Swatches”.
In the menu bar, go to:

Window > Color > Swatches

New Color Swatch
-ﬁ-

Swatch Name:{_New Color Swatch

[ Name with Color Value

@pe: | Process |4 ; )

— Color Mode: | CMYK

D Cyan s 0 %
Magenta . e 100 (%

Yellow e (100 (%

Black = 0 %

SPOT COLOR (PMS-PANTONE) Spot colors can be used in your publication when you are not
running full color photos or artwork and need only one or two color inks in addition to black. Spot
colors are identified by a corresponding Pantone/PMS number. In the color swatches menu, PANTONE

solid uncoated inks should be used for cold-web offset printing.

Window > Color > Swatches
New Color Swatch

Swatch Name: Mew Color Swatch

Name with Color Value

PANTONE

[] panTONE Yellow U

[] PANTOME Yellow 012 U
[O] panTONE Orange 021 U
[ PANTONE Warm Red U
B rANTONE Red 032 U
B PANTOME Rubine Red U




SIMPLIFY YOUR GMYK COLOR MIX FOR BETTER REPRODUCTION

The more ink used to create a color mix, the more likely that color will become muddy and darker when
printed, compared to it’s appearance on your monitor. Use these mixes as a guide.

100C 35Mm 100C 65M 100C 50M 30K 100M 30Y

100M 100Y 100M 100Y 20K 100M 100Y 20C

60M 20Y 20K 100M 20Y 20K 100M 40Y 40K

50C
15C 10K

100C 50M 100Y 100C 30M 80Y 75C 15M 75Y

10M 100Y

100C 100Y

~10C 40Mm

12C 22M 100Y

30C 60M 100Y 60M 100Y 40K

20M 60Y 40K 20M 100Y 40K 50M 100Y 60K
4 30C 15Y

20K | 50C 100Y 50K 20C 70Y 50K
10M 60Y 20K 10M 60Y 20K
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THINGS TO AVOID
BLACK TYPE IN ALL 4 COLORS

Be sure that any color ads/graphics created Black type created In RGB,

in Photoshop are done in the CMYK mode _
and that you are using Process BLACK, not converted to CMYK

a combination of CMYK process colors, or

Registration Black. For black and white ads,

use Grayscale mode. When black type is Black type in black ink only
created using all 4 colors, even slight mis-

registration on press can render the type

fuzzy and difficult to read. The ink also will

saturate and lead to more offsetting onto

the opposite page.

REVERSE (KNOCKOUT) TYPE IN ALL 4 COLORS
The minimum recommended point size for type reversing out of color backgrounds is
14pt. Even at this size it could present registration issues that lead to legibility being

compromised. It’s always better to use a bold San Serif typeface. Serif types should
be avoided altogether in reverses. See below...

14 pt type (Arial Bold) reversed

|4 pt serif type (Times)reversed

out of CMYK background

out of CMYK background

USING PHOTOSHOP FOR TYPE

When creating ads or artwork for your publication in Photoshop, avoid using text be-
low 12pt. if possible. Photoshop is a raster based program (using pixels) and will make
smaller type difficult to read. Be sure to start with a resolution of at least 300 dpi in
your ad/graphic image, and litle or no compression when saving.

MISSING FONTS

Fonts must be embedded and converted to outlines or paths before your document
is sent to print and before you convert / export to pdf. If you are sending a native ap-
plication file, be sure the fonts are embedded, and converted prior to sending. InDe-
sign has a package option (File > Package) that can gather all your fonts and links into
one package that can then be submitted for print if you are sending the native files.

RGB FILES

All files for commercial printing should be saved in the CMYK color space unless you are
sending a file with only | or 2 colors. These files should specify which PMS colors are used
and have those colors embedded within the file. Sending files in any other color space
may result in color shifts. Files sent with RGB color issues are usually placed on hold
while the printer notifies you. This could result in delayed production times.



PDF Export Settings

Once you've set up your publication in InDesign, the next step before sending it to the printer is to create
a print quality pdf.

Below is a set of screen shots that shows the settings to use. Access these settings by going to File >
Export in your InDesign menu bar.

Export Adobe PDF Export Adobe PDF

Adobe PDF Preset: | [Press Quality] \:* Adobe PDF Preset: | [Press Quality] (modified) | ]

Standard: | None i Compatibility: | Acrobat 5 (PDF 1.4) ‘:] Standard: | None : Compatibility: | Acrobat 5 (PDF 1.4) .

Ceneral General Eeneral Compression

|
|
|

Compression ; Compression
Marks and Bleads Description: | Use these settings to create Adobe PDF documents best Marks and Bleeds
ey suited for high-quality prepress printing. Created PDF Output | Do Not Downsample s 1 300 pixels per inch

documents can be opened with Acrobat and Adobe Reader Adicanced T : :
5.0 and later. for images above: 450 pixels per inch
Security Security

Compression: f-xﬁmmaﬁc (JPEG) = Tile Size: 128
Summary Summary ek ks ik —
— Pages Image Quality: | Maximum =
@ All

(JRange: 1 — Grayscale Images

— Color Images

Advanced

|1 Spreads | Do Not Dewnsample = 1 300 pixels per inch

for images above: 450 pixels per inch
— Options

) = Compression: | Automatic (JPEG) =) Tile Size: 128
[_|Embed Page Thumbnails |_| View PDF after Exporting —_—

EOplimize for Fast Web View Create Acrobat Layers Image Quality: I@

|| Create Tagged PDF

Export Layers: | Visible & Printable Layers [ ]

— Monochrome Images

| Do Not Dawnsample -1 1200 pixels per inch

— Include for images above: 1800 pixels per inch

"] Bookmarks || Non-Printing Objects Compression: | CCITT Group 4 |&
[ Hyperlinks "1 Visible Guides and Grids

Interactive Elements: | Do Not Include s | Compress Text and Line Art "] Crop Image Data to Frames

(" Save Preset... | ( Y (" Save Preset... ) £ ) Export )

Export Adobe PDF | Export Adobe PDF |
t |

Adobe PDF Preset: | [Press Quality] (modified) ':] +  Adobe PDF Preset: | [Press Quality] (modified) = i ‘

Standard: | None = Compatibility: | Acrobat 5 (PDF 1.4) [ | Standard: | None lii Compatibility: | Acrobat 5 (PDF 1.4) ™

e Marks and Bleeds General Output ‘

Compression Campression

— Marks
Marks and Bleeds Marks and Blasds

Output | All Printer's Marks : | Default (5 1 Output Color Conversion: | No Color Conversion
Advanced

Advanced ‘__'Crop Marks - (025 pt s Destination: = NfA
Security |_| Bleed Marks Security

Summary |_| Registration Marks - =10.0833 in Summary

— Calor

Profile Inclusion Policy: | Don't Include Profiles

|_|Color Bars

. e e
| Page Information Simulate Overprint { Ink Manager...

— Bleed and Slug — POF/X

¥ Use Document Bleed Settings Output Intent Profile Name:

Bleed: Output Condition Name:

Top: < 0.25 in @ Inside: Output Condition Identifier:

Bottom: = 0.25 in Outside: :
Registry Name

|_lInclude Slug Area

— Description

Color Conversion determines the type of profile conversion that will take place, If desired

—_———— - . ~ -
( Save Preset. ( ] ([ Save Preset... | ( Cancel

In the Marks and Bleeds settings, check only if your publication uses bleeds. The remaining settings can
be left to their default settings. Click Export and your pdf will be created.

The first time you do this, you should save your preset so it can be accessed through your Adobe PDF
Presets. This allows you to call it up without having to put in the settings each time you Export to pdf.
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PRINTING | PUBLISHING PRINT INFORMATION

TO INSURE THAT YOUR PUBLICATION IS COMPLETED TO YOUR SPECIFICATIONS,
PLEASE FILL OUT THIS FORM AND SUBMIT TO YOUR SALES OR CUSTOMER SERVICE REP

Customer Contact Information

Company Name:

Publication Name:

Primary Contact Name: Primary Contact Phone #:
email address: Home or Mobile Phone #:
2nd Contact Name: Phone: email:

Publication Information

Issue Date: Order Quantity: Total Number of Pages:

Pages to be printed in 4-Color:

Insert Information

Will this issue have any inserts?  Yes No Return extra inserts? Yes No
Insert Name: Quantity to insert:
Insert Name: Quantity to insert:
Insert Name: Quantity to insert:
Insert Name: Quantity to insert:
Insert Name: Quantity to insert:
Insert Name: Quantity to insert:

Delivery Information
Delivery Location #1 Delivery Location #2

Quantity to above location: Quantity to above location:

Special Instructions:




PRINTING | PUBLISHING
PHOTO GUIDELINES

Designing for newsprint is different to other mediums because the final outcome depends on designing for
inks on a highly absorbent paper. No matter how bright an image appears on your monitor, it will reproduce
darker when printed. At Stafford, we use a stochastic screening process which significantly helps with reproduc-
tion quality and reduces the absorption of ink into the paper.

On the pages that follow are some tips for getting better photo reproduction, including info on having your
monitor custom calibrated by Stafford for more accurate color display for print.

Note: Always use your camera’s highest resolution setting. You can always downsize your images to
a more manageable size (200-300 dpi) when preparing them for print.

COLOR MODE
Digital cameras create images in the RGB color mode. Before placing your photos into your print
document, you will need to convert them to CMYK mode for color printing, or Grayscale mode for
black and white printing. If photos are left in RGB mode and submitted for printing, color shifts will
occur that will result in less than ideal reproduction.

® Photoshop File Editm Layer Select Filter View Window Help

' Ps @ @ - ccrx ML o

5 Grayscale I

& Height  Adjustments > Dilatane D |
pho

Indexed Color...
Auto Tone a8l + RGB Color

Auto Contrast C{r3fL CMYK Color
Auto Color O ®B Lab Color

Multichanne|

Image Size... Kl
Canvas Size.‘.. X#HC 3 Bits/Channel
Image Rotation ¥ 16 Bits/Channel

Crgp 32 Bits/Channel
Trim...

Reveal All Color Table...
Duplicate...

Apply Image...
Calculations...

Variables
Apply Data Set...

Trap...

g B pGlpranreosn sk AS|nEl 0D

o - . = . : T { y ":‘ *".':. i,
Cnverting from RGB to CMYK in Photoshop

.




ADJUSTING PHOTOS
High contrast images lightened for good separation between tones will reproduce best. Photoshop provides
several methods for color /contrast adjustment. Below shows the Brightness / Contrast adjusment settings.

Try working with some of the other image adjustments options, such as Levels or Curves and the Shadow/
Highlight settings, all under IMAGE > ADJUSTMENTS in Photoshop.

i Photoshop File EditmmWr Select Filter View Window Help
D= B B 9+ eerx y Mode >

ST Adjustments » Brightness/Contrast... Clear

1 Levels... L
J Auto Tone 3L Curves...

=5 Auto Contrast {4 38L Exposure..

Auto Color {+3B

Vibrance..
Image Size... NEI Hue/Saturation... HU
Canvas Size... N#C Color Balance... #EB
Image Rotation > Black & White... C{+3#B
Crop Photo Filter...
Trim... Channel Mixer...
Reveal All

Invert
Duplicate... Posterize...

A A . & Apply Image... Threshold...
Ad]ustmg B”ghtHESS/Contf'GSt : & Calculations... Gradient Map...

using Photoshop | T i o Selective Color...

® Photoshop File Edit Image Layer Select Filter View Window Help
Ll WE > =~

1 o |
r-d vl Sample Size: | Point Sample & sample: | AllLayers & # Show Sampling Ring

+ photosample.jpg @ 66.7% (CMYK/8) *

S [ 0 |

L Ll I
ik~ i k- ool Dl i e

Brightness/Contrast

Brightness: 22

)
%
,

Contrast:

PEExFREpeENEASH

L]
&

g |

s p 3 4> ) ! = B ‘. o e ] prs P i H :
The image’s brightness and contrast should be adjusted to approximately 20% lighter than you
would choose for normal gloss photo printing. First adjust to what appears best on screen, then
lighten by about 20% for best newsprint reproduction.




IMAGE SIZE, DPI
After importing your photo into Photoshop, reconfigure the image dimensions to more closely approximate
the final size you plan to place it within your publication.

Photoshop File Editmmver Select Filter View Wi
(B B+ 667y Mode >

Width: + Height,  Adjustments b

Image Size

Auto Tone 3L | — Pixel Dimensions: 11.2M
Auto Contrast C{r#L |

Auto Color 4328 Width: [2100 | [ pixels [+ ]@ (" Cancel )
L) | Height[1400 | [pixels 4]

[ Auto.. )

A —

Image Size... Ll

Canvas Size... C . A | — Document Size:

Image Rotation | : - -
. Lo Width: | 7 | inches I.i
Crop . ]@

Trim... < Height:[4.667 | [inches |4

Reveal All i L . =
P | Resolutmn:|300 | plxelsflnchl.]

Duplicate... Bl ¥ scale Styles

. . ] . ¥ Constrain Proportions
Adjusting Image Size

; @Resample Image:
using Photoshop

| Bicubic (best for smooth gradients) e ]

L

COLOR CALIBRATION
NOTE:As a service to our customers, Stafford will gladly make arrangements to color calibrate
your monitor(s) to help insure that the image on your screen more closely matches reproduction
at press. Our calibration equipment will measure the ambient lighting in your work location to cre-
ate a custom setting for your monitor within your work environment.

Stafford also recommends that you use the “US Newsprint (SNAP 2007)” color profile in your
photo editing and design programs. Call your sales or customer service representative for more
information.

LINKS TO MORE TIPS

http://www.ehow.com/how_5968416_prepare-photos-newsprint.html

http://www.brainbell.com/tutorials/Photoshop/Preparing A_CMYK Image_For Use_In_Newsprint.htm

http://tn42.com/b/quick-steps-better-output-newsprint-web-press

https://youtu.be/9qjD6KbEIVA




AVOID USING LOW RESOLUTION WEB IMAGES FOR PRINT

All image files should originate from a hi-resolutions source. Images taken from the
web are configured at a much lower resolution than for printing purposes and will
reproduce looking blurry and with rough, “pixelated” edges. 300 dpi is the recom-
mended resolution for print reproduction. In your photo editing program, size your
images to as close to the final size it will run as possible. In Photoshop, image size is
controlled through Image > Image Size in the main menu bar.

Loi-res image - 72dpi

Hi-res image - 300 dpi




Uploading your publication to Stafford’s FTP Site

You can upload through our webpage without having to use an ftp client program:

Just go to www.go-stafford.com -

Go ahead, challenge us. There’s nothing
we can’t do together with paper, ink, and good ideas.

At the bottom right hand of our
home page is a + sign:

o UPLOAD A FILE

TO OUR FTP

Click on the + sign and then put in:
ftp.go-stafford.com

Login: (your login)
Password: (your password)

If you haven’t been assigned a login and password:
Login: test
Password: testtest

There are many free ftp client programs available online that can be configured quickly to give you quick
access to our ftp:

For MAC:

https://cyberduck.io/?l=en

For PC:
https://www.smartftp.com/

IF FTP IS DOWN

While ftp is the preferred method of file transfer, if you are unable to access our ftp site you can
go to www.wetransfer.com and use their service to provide us with an email link to your file. It’s

fast, and they provide an easy to use interface that allows transfers of up to 2gb.

When using this or any similar file transfer service, be sure to direct the files to our prepress

department’s email: prepress@staffordgroup.com and also cc it to your customer service
representative’s email address.




Frequent Contacts

John Moy, VP Sales (616) 788-7753 jmoy@staffordgroup.com

Pete Meade, (616) 745-8104 pmeade@staffordgroup.com
Customer Service, Tech Support

Prepress (866) 262-4449 x3080 prepress@staffordgroup.com

Eric Schardt, (616) 302-2691 eschardt@staffordgroup.com
Shipping, Warehouse Manager

Elliott Giddings, (616) 745-1172 x3070 egiddings@staffordgroup.com
Accounting

Chuck Pate, (616) 745-1172 x3079 cpate@staffordgroup.com
Accounting

1005 E. Fairplains Street
Greenville, Ml 48838
Ph: (616) 754-1178 Fax: (616) 225-1389

Resources

https://en.wikipedia.org/wiki/Offset_printing#Modern_offset_printing

InDesign
http://www.adobe.com/support/indesign/gettingstarted/index.html

Quark:

http://www.quark.com/Products/QuarkXPress/Quark_Training/

Acrobat:

https://www.youtube.com/watch?v=u8P9r7nwkHk

Photoshop:
http://www.ehow.com/how_5968416_prepare-photos-newsprint.html
http://tn42.com/b/quick-steps-better-output-newsprint-web-press
http://www.youtube.com/watch?v=RXtD9Nue2lA

All Abobe Programs:

http://tv.adobe.com/channel/how-to/




- Put aﬂ of y0ur :ssues at 'your readers
fmgerttps, wherever they are. Wlth féature!.’
» that your readers AND advert:sers will love.

- - — e i — e
» * Page Flipping e Content Pull Down Menu
e Streaming Video and Audio * Advertiser Pull Down Menu
e Active web links, email links * Archivable with searchable archives!
™ e Searchable Text e Printable

* Front and back page presentation pages ¢ Opens many new revenue opportunities
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